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A macro can be created to perform a variety of tasks, as simple or as complex as you desire. 
A macro may contain commands such as the Goto command, cursor movement commands such 
as moving the cell pointer with the arrow keys, cell entries, or anything else you might type from 
the keyboard. When you tell Excel to perform a particular macro, it executes the commands and 
keystrokes that have been stored for that macro one at a time. This type of macro is called a 
Command macro, since it is a sequence of stored commands. 

You may also create a second type of macro, called a Function macro. You have used 
functions already. You have used functions such as SUM, AVERAGE and HLOOKUP. The 
function macro is a function that you create. For example, you may have a complex formula that 
you want to be able to use in several spreadsheets . You could put the formula into a function 
macro, and then use it whenever you want. 

-12.3 CREATING MACROS TO EXECUTE SIMPLE TASKS 

Both command and function macros are placed in the cells of a special type of spreadsheet, 
called a Macro Sheet. Thus, to create a macro for a spreadsheet you must first create a macro 
sheet. The advantage of placing the macros on a separate document is that they may be used with 
multiple spreadsheets. All you have to do is keep cell references (or range names) consistent 
among the different spreadsheets. 

Once you have created a macro sheet, you enter the commands and actions you want the 
macro to carry out into the cells of the macro sheet. After you have typed into the cells the 
actions you want performed, you may tell the macro sheet the name of the macro. This is done 
with the named range feature. From then on, when the spreadsheet is active, all you need to do is 
enter the macro name to execute the macro. 

-12.4 RETRIEVE THE SPREADSHEET 

Before you begin to make a macro, start Excel and load the spreadsheet that you completed in 
Chapter II. To do this, boot your Macintosh with a System Start-Up disk, then insert the Excel 
Program disk into one of the computer's disk drives. If you are using a machine with a hard disk 
you will not need to insert the Excel program disk into a disk drive. Rather, locate the Excel 
folder, and open it so you can see the Excel program icon. Place the disk that has your saved 
model into another one of your Macintosh 's disk drives, if you have one available . This disk will 
be used for saving your work. If you do not have a free floppy disk drive, keep this disk 
available. You will need it for retrieval and storage. 

In these instructions , [cr] means to push the Return key on your computer's keyboard 
(remember, this is NOT the Enter key). A X in front of a letter (e.g. , XX) means to hold down 
the Command key while pressing the given letter. Letters enclosed in square brackets (e.g., 
[TAB] or [ENTER]) mean to push that key on the keyboard, and not to type out the word. 
Finally, the phrase "Click the mouse on . .. " means to move the mouse pointer to the specified 
item and push the mouse button once. The phrase " Double-click the mouse on .. . " means to 
move the mouse pointer to the specified item and double-click the mouse button. The word 
"drag" means to select an item, be it an icon or the menu selection bar, and move the mouse 
while the mouse button is pressed. 

Finally, if you want your work to match the figures in the text, be sure to use the Chooser DA 
to select a LaserWriter and not an lmageWriter. You may select a LaserWriter even if your com­
puter is not actually attached to one. You will not, however, be able to print if this is the case. 
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In this section you will , after loading the spreadsheet, name several ranges. This will be 
done before you begin to actual ly create the macros . You will see that the macros created in this 
chapte r will make use of the ranges you name. 

If you are using a computer with a hard disk , begin here: 

WHAT To Do 

Locate the icon for the spreadsheet you 
were working on in Chapter 11 and 
place the mouse pointer on the icon. 

Double-cl ick the mouse. 

WHY You ARE DOING lr 

You are going to launch Excel by double-clicking on this 
icon. It is called Model9. 

By double-clicking on an Excel spreadsheet , the Macin­
tosh will look on all available disks for the Excel applica­
tion program. If found, it will launch Excel and open the 
docume nt. If the Macintosh is not able to locate the 
application program, you will get an error message. 

If you have the Excel application program on your hard 
disk, or on a floppy disk currently in one of the com­
puter's disk drives, the program should start , and after a 
brief wait, the spreadsheet you saved at the end of Chap­
te r 11 will appear. 

If you are using a computer that has only floppy disks, then start here: 

Locate the icon for the Excel program. 

Move the mouse to the Excel icon and 
double-click. 

Move the mouse to the window's close 
box. 

Click the mouse button once. 

:l€0 

Click the mouse on the Drive button 
shown in the dialog box if your disk is 
not displayed in the dialog box. 

Click on Model9. 

You will launch the Excel application program by double­
clicking on it. 

The double-click will launch the application. If you have 
trouble with the double-cl ick, you may also select the 
program's icon with a s ingle click, then use the Open 
option on the File menu, or press :1€0, the command key 
equivalent. 

After a brief wait, Excel will be running, and you will 
have a new spreadsheet, called Worksheet! , in the 
window. 

Remember, the close box is the one found at the left of 
the title bar. 

Close the worksheet. You are going to open an existing 
worksheet, and it will be less confusing to work with 
only one document active. 

Execute the Open command. This command is found on 
the File menu. 

After a brie f pause, you will see the Open dialog box. 

The Drive button tells Excel to display the document and 
folder names found on a second disk currently in your 
computer. This may be a floppy disk, or a hard disk. If 
you do not have a second disk in the computer, then the 
Drive button will be dimmed, and you will not be able to 
use it. 

Continue clicking the Drive button until the name of the 
disk that contains your file appears in the dialog box. 

You want to open the spreadsheet you named " Mode19 ." 
By clicking the mouse pointer on the name in the dialog 
box, you are selecting this document. 
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Click on the Open button . Execute the Open command. After a brief pause while 
the computer reads the spreadsheet, you will see the 
Excel spreadsheet in the current window. 

You should remember that the double-click is often a 
shortcut to the Open command. You could have double­
clicked the mouse on the spreadsheet name, rather than 
selecting it and then click on the Open button in the dia­
log box. 

Before you continue, you are going to c reate some named ranges. These will be used in the 
printing macro and the goto macros you a re going to c reate in this chapter. 

WHAT To Do 

Pull down the Formula menu. 

Drag the mouse down to select Define 
Name. 

Figure 12.1 
The Define Name 
command has been 
selected. 

Release the mouse button. 

WHY You ARE DOING IT 

This menu has the Define Name command located on it. 

This command lets you name areas of the spreadsheet. 
Note that this command can be selected with the XL key. 

Apply Nemes ••• 

Note ... 

Goto... 886 
Find... 88H 
Replace ... 
Select Special ... 
Show Rctlue Cell 

Execute the Define Name command. You will see the 
Define Name dialog box. The text in the Name box 
should be selected , as it is in Figure 12.2. 

Figure 12.2 
The Define Name dialog 
box. 

liD Define Nome 

HOME [TAB] 

= $A$1 

ControLlable ~ c OK , 
Costs ~ Nome: 
lnRonge 

UniiMMI I ( 
Cancel ) 

Soles_Control 
SolesJol ( Delete ) 

Refers to: 

lo I · SRSI I 

Type the word HOME into the Name box, then press the 
TAB key. You are going to name cell AI "HOME". 

If the "Refers to" box does not have this text in it, enter 
this text. 



ControLTeble 
Costs 
lnRenge 
Seles_control 
Seles_Uol 

Click on the OK button. 

XL 

The_ Model 

[TAB] 

=$A$! :$P$11 

Click on the OK button. 

XL 

ModeL Control 
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Figure 12.3 
The current Define Name 
dialog box. 

Add the name HOME to the list of names. 

The Define Name command. 

Enter " The_Model " into the Name box of the Define 
Name dialog box. 

Move the highlight to the Refers to box. 

You want this name to refer to the range A I : P 11 . 
Remember that the dollar signs make this a fixed 
reference. 

Add the name " The_Model" to the list of names. 

The Define Name command. You are going to define 
another name. 

Enter "ModeLControl" into the Name box of the Define 
Name dialog box. 

[TAB] Move the highlight to the Refers to box. 

= $A$15: $H$17 You want this range to refer to the control table and to 
include the row labels found in column A. 

Click on the OK button. Add the name " ModeLControl" to the list of names. 

Pull down the File menu, select Save As You want to save the changes to the model before you 
and release the mouse button. continue. 

ModellO Name the model ModellO. 

Click on the Save button. Execute the Save command. 

These defined ranges will be used by the macros you are going to create. It is important to 
note that you do not have to define names in this fashion. You may use the cell addresses if you 
want. However, if for some reason the range definitions change, you would then have to modify 
the macro. By using range names in this fashion, the macro will not have to be changed if the 
ranges change. For example, consider what might happen if three more growth patterns and two 
more cost percent patterns are added to the range ModeLControl. By using named ranges, all 
you need to do is make sure that the range reference is correct. No changes need to be made in 
any macro that uses this range. 
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-12.5 CREATE THE MACRO SHEET 

You are now ready to create the macro sheet. Remember, Excel puts macros on a separate 
document so that you may use your macros for multiple spreadsheets. In this section you are 
creating the special macro sheet. 

WHAT TO Do 

Pull down the File menu. 

Drag the mouse down to select the New 
command. 

Figure 12.4 
The New command has 
been selected on the File 
menu. 

Release the mouse button. 

Move the mouse to Macro Sheet and 
click the mouse button. 

Figure 12.5 
The New dialog box. The 
Macro Sheet button has 
been selected. 

Click the mouse on the OK button. 

WHY You ARE DoiNG IT 

The File menu contains the New command. 

You are going to create a new document. There is no sep­
arate New command for macro sheets. All new docu­
ments (Spreadsheets, Macro sheets and, as you will see 
later in the text, Charts) are created with the New com­
mand. Note that you may use the XN key to execute the 
New command, rather than using the pull down menu if 
you so desire. 

Execute the New command. After a brief pause, the New 
dialog box will appear. 

You want to create a Macro sheet. If you fail to do this, 
Excel will create a new spreadsheet, rather than a new 
Macro Sheet. 

~· I , OK 
QWorksheet 
0 Chart ( cancel I ii, Macro Sheet 

Create the new Macro sheet. A new window, titled 
Macro l , will appear. 
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r a File Edit Formule Formet D11t11 0 tlons Metro Window 
., Figure 12.6 

The Macro Sheet has been 
created. You can see part 
of the Mode/10 window 
behind the Macro 1 
window. 

-12.6 YOUR FIRST COMMAND MACROS 

When you create a Macro, the commands are placed in a column of the Macro sheet. No empty 
cells are placed between commands, since that wi ll stop the macro's execution. It is also a good 
habit to place the macro's name into the first cell of the macro. 

In this text we are going to place a ll the macros in the A column of the Macro sheet. This is 
not, however, a requirement. You may place your macros in any column of the Macro sheet that 
you want. 

In summary, a macro occupies multiple cells in a column of the macro sheet. The first cell 
should be the name you want to assign the macro. Below this cell are the cells of the macro. All 
the macro cells begin with an equals sign, indicating that it is a function or computation , and not 
simply text to be displayed. Each macro command is then a one-word action followed by infor­
mation enclosed in parentheses . Some of the macro commands are made more readable by 
separating words with periods. Thus, rather than the command SETPRINTAREA, you will see 
the command SET.PRINT.AREA. 

The first macro that you create will make use of the Goto command found on the Formula 
menu. Recall that this command, which can be executed with the 3€G key, lets you jump the 
cursor to any location or named reference on the spreadsheet . The cursor should be in cell A I of 
the Macro 1 sheet. 

WHAT To Do 

Control [crJ 

WHY You ARE DOING IT 

This is the name by which this macro will eventually be 
known. You should get into the habit of assigning a name 
to all your macros, since it will make remembering them 
easier. 

By pressing the return key after entering this text , you 
will move the cursor to cell A2. 
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= FORMULA.G01D 
("ModeL Control") 

Figure 12.7 r • File Edit 

Enter this macro command into cell A2. In Figure 12.7 
you can see that the [cr] has not yet been pressed. You 
want the macro to execute the Goto command, found on 
the Formula menu. When it executes, you want the Goto 
command to select the area of the spreadsheet called 
ModeLControl. Remember that you earlier defined sev­
eral range names. This is the first of these that are now 
going to be used by your macros. 

It is important to note that the range name in the 
FORMULA.G01D command , ModeLControl here, 
must be enclosed in quote marks, because it is a range 
name, and not a direct cell reference. You may replace 
range names with direct cell references, which consist of 
the spreadsheet name and cell address separated by an 
exclamation point. For example, the ModeLControl 
range may be entered as Model!O!$A$1S:$H$17. If you 
do this you run the risk of needing to make major 
changes on a macro sheet if range definitions change, or 
if you change the name of the spreadsheet. Use range 
names whenever possible. 

Formula Format Date Options Macro Window 
, 

Cell Al on the Macro 1 
macro sheet will contain 
this command. The return 
key has not yet been 
pressed. 

A2 ~ :FORMULA.GOTO("ModeLControq 

: . 
·: ~ -~ 3 . -

[cr] 

=RETURN() [cr] 

[cr] 

Model [cr] 

= FORMULA.G01D("The_Model") 
[cr] 

A 
Mecrol 

B c 
lror 

-

Enter the command into cell A2 and move the cursor 
down to cell A3. 

,_ 

Enter the Return macro command into cell A4. All 
macros must end with e ither the RETURN or HALT 
command to return control of the spreadsheet to the user. 
If you forget this command you will receive an error 
message from Excel when the macro is executed. 

Don' t forget to include the parentheses after the 
RETURN command. Even though there is no informa­
tion enclosed within them, they must be included. They 
are part of the command. 

Move the cursor down to cell AS. 

You are going to write a second macro, starting in cell 
AS. You should always separate macros by at least one 
blank cell . Doing so makes the macro sheet a little bit 
easier to read. More important, the blank cell halts 
macro execution. The Cell A4 serves this purpose for us 
here. 

Name this macro Model. The cursor will move down to 
cell A6. 

You are placing another Goto macro on the Macro 1 
sheet. The command is placed into cell A6. 



=RETURN() [cr] 

[cr] 

Home [cr] 

= FORMULA.GOTO(" HOME") [cr] 

=RETURN() [cr] 
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Complete this macro. You now have two macros on the 
Macro! macro sheet. 

Move the cursor down to cell A9. Again, you are leaving 
a blank cell between two macros. 

This macro will be named Home. The cursor is moved to 
cell AIO. 

The action of this macro starts in cell A 10. The cursor 
will be moved to cell A 11 . 

Complete this macro. You now have three macros on the 
Macro 1 macro sheet. 

,. It File Edit Formula Format Data 01 
Figure 12.8 
The current Macro1 macro 
sheet has three macros. A12 I J 

Macro! I 
A 8 

1 Control 
Z ; fORMULA.GOTO( .. Mode1-C2,!!; ----H-------

3 •RETURN() 

5 Model 
6 •fORMULA.GOTO( lheJ1odel 

\1 t ·::~JL 
I 0 •fORMULA:-:-::.GO::T':::O-r.( .'""tll:::-:M'""E'"=·)..-+----
11 •RE' RN -
12 

-M- -------·----------=--===-= 
n :: 

16 

Pull down the Window menu, select 
Modei!O at the bottom of the menu, and 
release the mouse. 

Pull down the Macro menu. 

Activate the window called ModeiiO. When you release 
the mouse, the spreadsheet window containing your 
model wi ll move to the front , on top of the Macro! win­
dow. Remember that you may also click the mouse on 
any visible portion of an inactive window to activate it. 

Figure 12.9 
Mode/10 has been selected 
on the Window menu. 

This menu contains the command you need to execute a 
macro. 
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Select the Run command. 

Figure 12.10 
The Run command found 
on the Macro menu has 
been selected. 

Macro i!AI 

Figure 12.11 
The Run dialog box. The 
macro to be executed has 
been entered in the 
Reference box at the 
bottom of the dialog. 

Click the mouse on OK. 

Figure 12.12 
After the macro executes, 
the named range in the 
Goto command is selected. 

This is the command needed to execute a macro. Note 
that it does not have a command key (X) equivalent. 

St~ t llt~eonl<!r 

fl e l<tl it•<! II<H ortl 

RF. 7F. Ql tn 

Enter the location of the macro that you want executed. 
This location consists of two parts, separated by an excla 
mation point. The first part of the location, Macro I, tells 
Excel the name of the Macro sheet that is holding the 
macro you want executed. The second part of the loca­
tion, A I , tells Excel in which cell of the macro sheet the 
macro begins. 

10 Run - ----

Run 

~· 
OK , 

C11ncel ) ( 

Reference: L.l M_a_c_r_o_l_l R_l.:..l ----------' 

Execute the macro. The range ModeLControl will be 
selected. 

s M11cro Window 

1 09.27 116.31 1 26.47 133.59 

9.0'JI& 9.0'JI& 7.0'JI& 5.0'JI& 5.0\l 
67.0'JI& 67.0'JI& 66.0'JI& 65.0\l 65.0'JI& 65.0\l 

., 



Pull down the Macro menu , select Run 
and release the mouse. 

Macrol!AS 

Click on the OK button. 

Pull down the Macro menu, select Run 
and release the mouse. 

Macrol!A9 
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You are going to execute another macro. 

You want to execute the second macro you entered, which 
starts in cell AS. 

Execute the macro. The spreadsheet from cell A I 
through cell PII is selected. 

You are going to execute your last macro. 

The macro that starts at cell A9 of the macro sheet will 
return the cursor to cell AI . 

Click on the OK button. Execute the macro. The cursor will return to cell A I, 
which was named HOME. 

Pull down the Window menu , select You want to activate the Macro! window. 
Macro! and release the mouse. 

Pull down the File menu , select Save As You want to save this macro sheet. 
and release the mouse button. 
Macsl Name this macro sheet Macsl. 

Click on the Save button . Save the macro sheet you have created. 

-12.7 NAME THE MACROS 

Just as you may name cells and ranges of your spreadsheet models, you may name the macros 
that you create. This will make it easier to run your macros, since you will not have to remember 
where you have placed them on the macro sheet. 

WHAT TO Do 

Use the mouse to select ce ll A I of the 
Macs I macro sheet. 

,. • File Edit Formula Format 
AI I I Control 

A 
1 contra! 
2 •FORMULA.WIU\ r!C!!JOI. on 

~ •RETURN( 
4 
5 Model 
6 •fORMULA.GOTIK ll\!J1ode1 

Dl 

M1 

r-J- ':'_RETURN( ----8 
9 rto Home 

;FORMULA.GOTO "I«<ME" 

WHY You ARE D OING IT 

You are going to assign a name to the macro that starts in 
cell Al. This macro will be called Control, since that 
name already appears in the cell. 

Figure 12.13 
The first cell of the macro 
that you are going to 
name has been selected. 
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XL 

Click the mouse on the Command 
button. 

Move the mouse to the Option + X Key 
box and click the mouse button once. 

c 

Figure 12.14 
The Define Name dialog 
box used with the Macro 
sheet asks for additional 
information. This figure 
shows the name you have 
assigned this macro, and 
that the Command button 
has been selected. 

Click on the OK button. 

Use the mouse to select cell A5 of the 
Macs I macro sheet. 

XL 

Click the mouse on the Command 
button. 

Click the mouse in the Option + :M: Key 
box. 

m 

Use the Define Name command. This command is found 
on the Formula menu. Notice the Define Name dialog 
box that appears has information that you did not see 
when you were using this command with a spreadsheet. 

The name "Control" appears in the Name area of the 
dialog box. Since you have selected cell A I , the refers to 
portion of the dialog does not need to be changed. 

This button is located in the lower portion of the dialog 
box in the area labelled Macro. You are doing this to tell 
Excel that you are defining a Command macro. A func­
tion macro can also perform some tasks, but when it is 
done it tells the spreadsheet some information, usually 
the results of computations. 

When you clicked on the Command button, the 
Option+ X Key box of the dialog box became active. You 
may assign your own choice of command key equivalent 
for your macros. To distinguish your command keys from 
the ones normally used by Excel, you must use the 
Option key with the X. 

You are going to enter a letter into this box. 

Enter a lowercase "c" into the box. 

·- -
Define Name 

I OK 
Name: 

Canc:el I Control 

Refers to: 
Delete 

I·SRSI 

® Command Optlon+X Key: EJ 0 None 

Complete the dialog box. 

You are going to assign a name to this macro. 

The Define Names command. The name Model wi ll 
appear in the Name box on the Define Name dialog. 

I 

Tell Excel that the named cell is the start of a command 
macro. 

You are going to assign a key equivalent for this macro. 

Enter a lowercase "m" to be the Option +X key 
equivalent. 

I 
I 
I 



Click on the OK button. 

Use the mouse to select cell A9 of the 
Macs I macro sheet. 

XL 

Click the mouse on the Command 
button. 

Click the mouse in the Option +X Key 
box. 

h 

Click on the OK button. 

xs 

Pull down the Window menu, select 
ModellO, then release the mouse 
button. 

Pull down the Macro menu, select the 
Run command, then release the mouse 
button . 

Run 

Run 
Q I c MacsiJControl 

( h Macsi JHome 
m MacsiiModel 

~ 0 
Reference: II 

Click the mouse on the third macro in 
the list. 
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Complete the dialog box. 

You are going to assign a name to this macro. 

The Define Names command. The name Home appears 
in the Name box. 

Tell Excel that the named cell is the start of a command 
macro. 

You are going to assign a key equivalent for this macro. 

Enter a lowercase " h" to be the Option + X key 
equivalent. 

Complete the dialog box. 

Save the changes that you have made to the Macs 1 macro 
sheet. 

The worksheet must be active so that you can try using 
the names of the macros, rather than entering their cell 
addresses. 

You want to run one of the macros. The Run dialog box 
now lists the macros you have named . 

OK 

Cancel 

, 
l 

I 

Figure 12.15 
The Run dialog box shows 
the three macro names. 

You can see the Option +X Key equivalent letters that 
you have assigned the three macros in front of each 
macro name. 

This is the Model macro. 

Figure 12.16 
The Model macro has been 
selected. 
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Click on the OK button . 

[OPTION] [SHIFT] ~C 

[OPTION] ~c 

[OPTION] ~h 

-12.8 A MACRO TO PRINT 

Execute the macro. The model will be selected. 

Hold down the option key, the shift key, and the com­
mand key, then press the letter " C". 

The computer will beep at you, and nothing will happen. 
When you defined the equivalent key, you used a lower­
case letter "c" . Holding down the shift key is telling 
Excel to look for a macro with a capital " C " as the 
equivalent. 

Try executing the macro again. Hold down the Option 
and Command keys, then press a lowercase "c". 

The selected area of the spreadsheet should change to the 
table at the bottom of the window. 

Use the macro you have defined to return the cursor to 
cell A I. 

You are now ready to c reate a macro to print your spreadsheet. This macro will save the model 
before it begins the print process so that if you have problems your work will not be lost, then it 
sets the print area, and finally executes the print command. 

WHAT To Do 

Pull down the Window menu, select 
Macs I then release the mouse. 

Click the mouse in cell A 13. 

PrLModel [cr] 

= SAVE() [cr] 

= FORMULA.GOTO("The_Model ") 
[cr] 

= SET.PRINT.AREA() [cr] 

= PRINT(I , I , I , I , FALSE,,) [cr] 

WHY You ARE DoiNG IT 

Make the macro sheet active. 

This is where you will start the mac ro. 

This will become the name for this macro. The [cr] will 
move the cursor to cell A 14. 

This is the Save macro command, and should be entered 
into cell Al4. It is the same as using the Save command 
found on the Fi le menu, or as using the ~S key. The cur­
sor will be moved to cell A 15. 

You are going to set the print area to be just the model 
showing the computations and the growth and cost rates. 
The control table will not be printed. This command 
should be ente red into cell A 15, and the cursor is moved 
to cell A l6. 

This is the macro command for the Set Print Area com­
mand found on the Options menu, and should be put into 
cell A l6. The cursor will be moved to cell A I? when you 
press the [cr] . 

This is the Print command, and should be in cell A 17. 
As you can see, there are several items of information 
you must supply this command. 
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The first of the four I 's controls whether you want to 
print all the pages, or a range of the pages. By entering a 
I as the first item here you are selecting the print all 
pages choice. Because of this, the next two I 's are 
ignored. If you had entered a 2 at this point, you would 
be telling Excel that you want to print a selected subset of 
the pages. The next two 1 's then tell Excel at which page 
to start printing and at which page to stop. 

The fourth one is the number of copies you want printed. 
In this case, just one! 

There is no fifth value. It is reserved for the IBM-PC 
version of Excel. Thus the two commas with nothing 
between them. 

The sixth position, in this case the word FALSE, controls 
whether you want to see the print preview. False means 
you do not, whereas entering TRUE means you want to 
see the print preview. 

We want Excel to ignore the remaining arguments to this 
command. Their spaces must be reserved, however, and 
thus the three commas after the word False. The argu­
ments correspond to the Parts option, the Print Using 
Color option, and the Sheet Feed option. 

= FORMULA.GOTO("HOME") [cr] After printing, you want the cursor to return to cell Al. 
This command should be entered into cell Al8, then the 
cursor moved to cell Al9. 

"'DELETE.NAME("PrinLArea") [c r] You should recall that, when you set the print area, a 
name called "PrinLArea" is added to the defined names 
list. This macro command will remove this name from 
the names list. It is similar to using the Define Name 
command, selecting the name and then clicking on the 
Delete button. This command should be placed into cell 
Al9. 

=RETURN() [cr] Remember, you must always end a macro with a 
RETURN command. This command should be in cell 
A20. 

Figure 12.17 
The A column of your 
macro sheet, called Macs1, 
should now look like this. 
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Select cell A 13. 

Click on the Command button. 

Move the mouse to the Option+ :M: Key 
box and click the button. 
M 

Figure 12.18 
The completed Define 
Name dialog box. 

iD 
Control 
Home 
Model 

You are going to assign this macro the name PrLModel, 
which is found in th is cell. 

The Defi ne Name command. The name PrLModel, short 
for Print the Model, should appear in the Name box of 
the Define Name dialog box. 

Remember that you must tell Excel that you have created 
a command. 

You want to assign an equivalent key. 

Use a capital letter "M", rather than a lowercase letter. 

Define Name 

I OK , 
N11me: 

( ) 
IPrLModel 

Cllntel 

( Delete ) 
Refers to: 

I=SR$13 I 
Mlltro-------------------------------------, 

0 Function ® Comm11nd Option+ X Key:~ 0 None 

Click on the OK button. Complete the dialog box. 

:M:S Save the changes you have made to the Macs I macro 
sheet. 

Pull down the Window me nu, select 
Model 10 and release the mouse. 

Pull down the Macro menu, select the 
Run command and release the mouse . 

Figure 12.19 
The Run dialog box shows 
the new macro. 

Click on the Cancel button. 

[OPTION] [SHIFT] :M:M 

You want to try this new macro. The Spreadsheet window 
must be active. 

Begin execution of a macro . You can see that the macro 
you have added is now in the list of macros in the Run 
dialog box. 

I . -

Run 
c MIICSIIControl 
h MlltSI!Home 
m MIICS11Model 

Run 

M MIICS11PrLModel ~ 

Reference: I 
~--------------------~ 

Cancel the Run command. You are going to try using the 
key equivalent. 

Hold down the Option, Shift and Command keys, then 
press the "M". Excel will print the spreadsheet. If you 
forget to hold down the Shift key, you will be executing 
the macro to select the model. If this happens, you will 
not see the printer dialog appear. 
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If you do not have a printer attached to your computer, or 
you have chosen the LaserWriter and you have only an 
ImageWriter, you will receive an error message from the 
Macintosh. To continue, click on the OK button. Excel 
will then give you a Macro error message. Click on the 
Continue button. 

12.9 CREATING A FUNCTION MACRO 

A function macro is used to simplify your model building. You may use a function macro to 
summarize an arithmetic formula on the spreadsheet and make it easier to use. When you do 
this, the function name appears in a cell of the spreadsheet. When the function is executed , 
information is sent to the macro sheet holding the function. The formula is computed by the 
macro sheet, and the answer is passed back to the cell in the spreadsheet that used the formula. 
For example, you may want to make a function called Profit that performs a subtraction equiva­
lent to the computation found in cell B6 of the current spreadsheet. That is, the Profit function 
will take two values, called arguments , and subtract one from the other. The result of the 
subtraction is sent back to the spreadsheet by the RETURN command. The arguments are placed 
between the parentheses when you enter the function. For example, the IF function that you used 
in an earlier chapter has three arguments: the comparison, the computation if the comparison is 
true, and the computation if the comparison is false. The Profit function you will create will have 
only two arguments: sales and costs. 

The advantage of using a funct ion is that it can then be used in othe r spreadsheets. You do 
not have to recreate the formula. This can be a time saver when you build complex spreadsheets 
that use the same computations over and over. 

You should note that while the function you are about to create will work, it is be ing created 
here to be an example of functions, and not of good style for creating spreadsheets. You will 
probably agree that the formula that is presently in cell B6 is easy to read, and not particularly 
difficult to enter. Keep this in mind as you work this section of the text. 

WHAT TO Do 

Pull down the Windows menu, select 
Macs I and release the mouse button. 

Scroll the window so that you can see 
empty cells below the PrLModel 
macro. 

WHY You ARE DOING IT 

Make the macro sheet, Macs l , the active window. 

You are going to put this function into cells below the 
PrLModel macro. 

Move the mouse pointer to cell A22 and You are going to start the function in cell A22. 
click the mouse. 

Profit [cr] Enter the word Profit into cell A22 and move the cursor 
to cell A23. Profit will be the name of the function. 

=ARGUMENT(" sales") [cr] The first step to building a function macro is to define the 
arguments, or information, that it will· need. Here, the 
first number accepted by the Profit function will be the 
sales value. When the function macro is executed , which­
ever value appears first in the list of arguments will rep­
resent "sales" to the funct ion. The cursor should end in 
cell A24. 
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=ARGUMENT("costs") [cr] 

= (sales-costs) [ cr] 

= RETURN(A25) [cr] 

Figure 12.20 
The Profit function macro 
is in cells A22:A26. 

Click the mouse on cell A22 . 

a€L 

Click on the Function button. 

Click on the OK button. 

a€S 

Pull down the Window menu , select 
ModellO and re lease the mouse button . 

Click the mouse pointer on cell B6 . 

= Macsl !Profit(B4,B5) [ENTER] 

The second number that appears in the argument list will 
be used by the Profit function to fill in the "costs" value. 
The cursor should end up in cell A25. 

Enter the computation that the function is to carry out 
into cell A25 , and move the cursor to cell A26. 

The RETURN command ends the macro. In this case, 
you want the function macro to report back the results of 
the computation that is carried out in cell A25 . 

,. • File Edit Formula Forn 
A27 l l 

JRN( 

~ .. · ': . . ! 
.• Reedy 

Select cell A22 before you name the macro. 

The Define Name command . Profit should appear in the 
name area of this dialog box. 

Remember that this is a function, not a command. The 
Option+ a€ Key box wi ll remain dimmed , since com­
mand keys are not appropriate for functions. 

You are done naming this fu nction. 

Save the modified Macs l macro sheet. 

Reactivate the spreadsheet window. 

This cell is where you wi ll test the funct ion you have just 
created. 

You must tell Excel where to find the function, Profit. It 
can be found on the Macs I macro sheet. Remember to 
separate the location of the function from the function 
itself by the exclamation point. Use the enter key to keep 
the cursor on cell B6. 
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,. Figure 12.21 • File Edit FormUIII Formot D11t11 0 The Profit function has 
been entered. There is no 
change in the result, since 
the Profit function 
performs the same task as 
the original formula did. 

66 I I : Mocs 11Proflt(B4,BS) 

Modell 0 I 

:: f--1--
A B c D 

AJIC CO . 

:: f-4-. 1970 1971 197 
: :~ 

100.00 109.00 ::r-4-. I.U.U 118.8 

:: 5 COITI 67.00 73.03 78.4 

:!+ PIIOFJT I 3~ col 35.97 40.4 

-12.10 ADDING AN ITEM TO THE MENU BAR 

It would be nice to be able to access the macros that have been created through a menu. This is 
especially true if you create a large number of macros. While the Option+ X key equivalent is 
handy, you may not always remember what to use for which macro. Thus, a menu would be 
valuable. 

You may add an item to the menu bar by using a macro. To do this, you must first create the 
menu information in cells of the macro sheet , then create the macro to add the menu to the menu 
bar. The menu information uses two columns of the macro sheet. The first entry of the left 
column holds the name of the menu. Below the name a re the cells holding the text which is to 
appear when the menu is pulled down, that is, the commands. To the right of each command 
description is the name of the command macro to be executed when the item is selected. 

WHAT To Do 

Pull down the Window menu, select 
Macs l and re lease the mouse button. 

Move the mouse to cell A30 and click 
the mouse button. 

MyMenu [cr] 

Select cells A31 :B34. 

Home the Cursor [ENTER] 

Home [ENTER] 

Select the Model tENTER) 

WHY You ARE DoiNG IT 

Activate the macro sheet window. 

Select cell A30. This is where you will begin the menu. 

Enter MyMenu into cell A30 and press [cr] to move the 
cursor to cell A3l. This is going to be the name of the 
menu when it is added to the menu bar. 

This is where you will enter the rest of the menu 
information. 

The first command on the menu will return the cursor to 
cell A I. Place this text into cell A3 I , then press the 
[ENTER] key to move the cursor ri~ht to cell B31. 

This is the name of the macro you wrote to move the cur­
sor to cell A l. It will be executed when you select the 
" Home the Cursor" command on the menu MyMenu. 
Press [ENTER] to move the cursor to cell A32. 

The next command on the menu will select the Model. 
After you press [ENTER], the cursor should be in cell 
B32. 
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Model [ENTER] 

Select the Control Table [ENTER] 

Control [ENTER] 

Print the Model [ENTER] 

PrLModel [ENTER] 

Figure 12.22 
The menu information has 
been entered into the 
macro sheet. 

Click the mouse on cell A36. 

AddMyMenu [cr] 

= ADD.MENU(l ,A30:834) [cr] 

=RETURN() [cr] 

This is the macro you wrote to select the model. Put its 
name in cell 832, and move the cursor to cell A33. 

The th ird command on the new menu will select the Con­
trol Table. 

Place the name of the macro into cell 833, then move the 
cursor to cell A34. 

This is the last item you will place on your menu. 

The name of the macro to be executed is placed into cell 
834. 

You have now laid out the information for the menu. The 
left column of information are the commands as they will 
appear when the menu MyMenu is pulled down. The 
right column are the names of the command macros to 
be executed by each respective command on the new 
menu. 

You must now create the macro that identifies the menu 
to Excel, and makes the menu appear on the menu bar at 
the top of the Macintosh display. 

This is where you will put the macro to add the menu. 

This will be the name of the macro. The cursor wi ll 
move to cell A37. 

The ADD. MENU command will add a menu item to the 
specified menu bar. The arguments of the command are, 
first , the number of the menu bar where the menu is to 
appear. The value I , which you entered here, selects the 
menu you see when working with Worksheets and Macro 
sheets, and Full menus have been selected. If you want to 
add a menu to the Chart menu, you would use a 2 instead 
of a I . 

The second item, A30:834, tells Excel where on the 
macro sheet to find the information that describes the 
menu. This range includes the cell that h'olds the name of 
the menu, cell A30. 

Don't forget the return CO!llmand in cell A38 to indicate 
the end of the macro. 



[cr] 

ZapMyMenu [cr] 

= DELETE.MENU(l , " MyMenu") [cr] 

=RETURN() [cr] 

Click on cell A36. 

XL 

Click on the Command button. 

Click on the OK button. 

Click on cell A40. 

XL 

Click on the Command button. 

Click on the OK button. 
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Place the cursor into cell A40 on the macro sheet . You 
are going to create one more macro. 

This will be a macro to remove the menu from the menu 
bar. 

Enter this command into cell A4 1. As you can see, there 
are once again two arguments for this command. The 
first tells Excel which menu bar has the menu you want 
to remove, and the second argument gives the name of 
the menu to be removed. 

End the macro in ce ll A42. 

Figure 12.23 
The macros to add and 
remove the menu item 
have been entered. 

Select cell A36. You are going to define the macro names 
for Excel. 

The Define Name command. AddMyMenu should 
appear in the Name box. 

This is a command macro, not a function macro. 

You do not want to assign an Option + ~ Key for this 
macro. It will not be used that often, so you are going to 
save your letters. 

Select cell A40. You are going to define this macro 's 
name for Excel. 

The Define Name command. ZapMyMenu should appear 
in the name box . 

This is a command macro, not a function macro. 

You do not want to assign an Option+~ Key for this 
macro. It will not be used that often, so, once again, you 
are going to save your letters . 
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XS 

Pull down the Window menu , select 
ModeiiO then release the mouse. 

Pull down the Macro menu , select Run 
and release the mouse. 

Click on the AddMyMenu macro name. 

Figure 12.24 
The Run dialog box. Note 
that the AddMyMenu 
macro does not have a 
letter in front of it since 
you did not assign an 
Option + :K Key to the 
macro. 

Click on the OK button. 

Save the changes you have made to the Macs I macro 
sheet. 

You are now ready to add the menu to the menu bar. 

Make the spreadsheet the active window. 

You are going to execute the AddMyMenu macro. Since 
you did not assign this macro an Option+ X Key, you 
must use the Run command to execute it. 

This is the macro that you want to run. 

Run 

·R·u~nii:Qri!ll.ll;llllllll••l§J l OK J 
c MacsiiControl ( Cancel 
h MacstiHome 

Reference: 

Execute the macro. MyMenu will appear at the right end 
of the menu bar. 

Figure 12.25 
MyMenu appears on the 
menu bar. 

' * File Edit Formula Format Data ilptlons Macro Window MyMen 
66 I I :Mecs 11Proflt(B4,B5) 

:(iri Mntloll n II 1,.:_ 

This menu works just like the standard Macintosh menus. Use the mouse to pull down the 
me nu and select the item you want. Execute the item by releasing the mouse button. Let 's try 
executing some of the commands on the menu to make sure that you have properly created the 
me nu. 

WHAT To Do 

Pull down MyMenu . 

Drag the mouse down to the third 
option, Select the Control Table. 

Figure 12.26 
The Command "Select the 
Control Table " has been 
selected. 

Release the mouse button. 

WHY You ARE DOING IT 

You are going to try the commands on the menu you have 
just c reated . 

You are going to select the control table at the bottom of 
the spreadsheet. 

Execute the command . The control table at the bottom of 
the display should become selected. 



[OPTION] :M:h 

Pull down the Macro menu, select Run 
and release the mouse. 

Select ZapMyMenu in the macro list. 

Run 
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This is the keyboard equivalent for the Home macro. The 
cursor will return to cell A l. 

Just because you have placed an item on an active menu 
does not disable the Option+ :M: Key to activate that 
command. 

You want to run a macro. 

Scroll the macro list window to make the ZapMyMenu 
macro name appear. 

You want to remove the menu . 

Figure 12.27 

rR~u:-:n:-:-:--:-:-:-----:-~-----..,.. ( OK J 
c MIICSIIControl ~ ~ 

The ZapMyMenu macro 
has been selected. 

h Mecsi!Home ( Cancel 
m MIICSIIModel 
M MIICSIIPrLModel 

~d( \I !/.IJ1"11j"1PIIU 

Click on the OK button. 

-
Execute this macro. The MyMenu menu will be removed 
from the menu bar. 

12.11 MAKING A MACRO EXECUTE WHEN THE 
SPREADSHEET LOADS 

Having a macro execute when the spreadsheet loads, called an autoexec macro, can be very 
helpful. For example, you may always want the menu MyMenu added to the menu bar. This can 
be done by making the macro AddMyMenu execute whenever the spreadsheet model is loaded 
into Excel. 

Additionally, s ince you have changed the formula in cell B6 to use a macro function (you 
remember the Profit function) , it is desirable to have the macro sheet loaded so that the function 
can be used by the spreadsheet. Always keep this latter fact in mind when creating functions. 
That is, the macro sheet must be loaded with the spreadsheet for the functions defined on it to be 
available. If you load just the spreadsheet, and not the macro sheet, Excel will not know how to 
evaluate the function. 

Making a macro into an autoexec macro simply requires that a special name be defined in 
the spreadsheet that is to load the macro. At present, you should have the spreadsheet ModellO 
displayed as the active window. If not, use the window menu to make ModellO the active 
window. 

WHAT TO Do 

:M:L 

auto_open 

WHY You ARE DotNG IT 

The Define Name command. 

This is the special range name that tells Excel to automat­
ically load a macro sheet and execute a macro. Enter it 
into the Name box on the Define Name dialog. Make 
sure that you enter this name using lowercase letters and 
a single underscore to connect the two words. If you do 
not do this, the autoexec macro will not work. 
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[TAB] 

= Macsl !AddMyMenu 

Figure 12.28 
The Define Name dialog 
box that you are creating. 

Click on the OK button. 

:M:S 

Click on the spreadsheet close box. 

:M:S 

Click on the macro sheet close box. 

3€0 

10 

Move the selection to the " Refers to" box. 

This is the name of the macro sheet, and the name of the 
macro to be executed. 

Define Name 

ControLlable ~ c OK , 
Costs 

~ Name: ( ) HOME 

~~ lauto_open I 
Cancel 

lnRange 
ModeL Control ( Delete ) 
Sales_Control ~ 

Refers to: 

SalesJol , .. Macs11 RddMyMen~ I 

Save this name. 

Save the spreadsheet changes. 

Pur away this spreadsheet. You are going to try opening it 
to see if the menu gets loaded automatically. The Macs I 
macro sheet should still be open. 

Make sure that the macro sheet has been saved. 

Put away the macro sheet. When the Model!O spread­
sheet is opened the macro sheet also should get loaded by 
the autoexec macro feature. 

The Open command. 

Locate the spreadsheet called Model!O in the dialog box 
and select it. 

Figure 12.29 
Mode/10 has been selected 
in the dialog box. 

' lit ~ Edit Window 
., 

I I 

(g) MY DRTR 

Eject 

Driue 



Click on the Open button. 

Update references to 
unopened documents? 

~ 

Click on the Yes button. 

XS 

XQ 

EXERCISES 

I 
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Open the Modei!O spreadsheet. 

After a brief pause you will see a dialog box that asks 
"Update references to unopened document?" This mes­
sage is a result of using the Profit macro function . The 
macro sheet has not yet been opened, so that the Profit 
function is not available to the spreadsheet. 

Yes I 
No 

Figure 12.30 
You will see this alert 
message because the Profit 
function macro has not yet 
been loaded. 

Let Excel update the references. If you quickly look at 
cell 86 while the loading process continues, you will see 
the REF# error message appear. Don' t worry. 

Once the spreadsheet has been updated, it will load the 
Macs I macro sheet. You will see it become the active 
window. 

After another pause you will see MyMenu added to the 
menu bar, and the spreadsheet will return to being the 
active window. Finally, since the Profit function is now 
available in the computer's memory, the function is prop­
e rly evaluated in cell 8 6. 

Save the model one more time. 

Quit Excel and return to the Macintosh Finder. 

l . Where should you put the name of a macro? 
2 . Explain the difference between a Command macro and a Function macro. 
3. Are macros placed on a spreadsheet document or a macro sheet document? 
4. What is the advantage to placing macros on a macro sheet rather than on a spreadsheet? 
5 . Which menu command is used to create a macro sheet? 
6. What is the macro statement used to execute the Goto command? 
7. If you have defined a range called " RighLSide" , write the macro that will select this range. Name the macro GoRight. 
8. What command must end every macro? 
9 . What is the command used to name a macro? 

10. If you have not assigned a name to a macro using the Define Name command, how can you get Excel to execute the 
macro? 

II. When you enter the location of a macro that you want executed by Excel , what character separates the name of the macro 
sheet from the cell address that starts the macro? 

12. What is an advantage to naming a macro? 
13. Can you assign a Command Key (X) equivalent to your macros? 
14. Can you assign an Option+ Command Key (X) equivalent to your macros? 
15. When you use a keyboard equivalent to execute your macro, does it matter if you press a capital letter when the name was 

assigned using a lowercase lette r? 
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16. Using the spreadsheet you were working with in this chapter, create a macro to print only the first three years of the sales 
projection, rather than the complete sales projection. 

17. Using the spreadsheet you were working with in this chapter, create a macro to print the range ModeLControl. 
18. Add the two macros you created in Problems 16 and 17 to the menu you created in this chapter. 
19. Create a new menu for the spreadsheet you used in this chapter. The menu should be called Printlt. On the menu should 

be the following commands: 
Print the Complete Spreadsheet 
Print the Sales Projection only 
Print the Sales Projection with costs/ growth % 
Print the current Control Table 

20. Create a macro that will add the print menu you created in Problem 19 to the menu bar for the spreadsheet. 
21. Create a macro that will remove the print menu you created in Problem 19 from the menu bar for the spreadsheet. 
22. What is the name you must assign a macro to have it loaded automatically when the spreadsheet is loaded? 
23. Create a function macro, to be called BrkEven, for the break-even formula: 

Break-even Point = Fixed Costs I (Selling Price- Variable Costs per unit) 

24. Use the BrkEven function you have created to compute the break-even when Fixed Costs are $2295.00, Selling Price is 
$14.95, and the Variable Cost per unit is $100.00. 

25. When you define a menu, must the menu options be in adjacent columns or in consecutive rows of the macro sheet? 
26. When you define a menu, where is the name of the macro to be executed by an option placed? 
27. Must a named range be a unique range, or can it overlap with another named range? 



DATABASE MANAGEMENT 
SYSTEMS CONCEPTS 

-CHAPTER OBJECTIVES: 

Upon completion of this chapter, the student will : 

-

• Define database. 
• Define database management system (DBMS). 
• Give at least three reasons why a database 

management system should be used. 
• Differentiate among menu-driven DBMS, 

command language driven DBMS, and 
programming languages. 

13.1 WHAT IS A DATABASE? 

CHAPTER 

13 

• Describe the difference between hierarchical/ 
network type DBMS and relational type 
DBMS. 

• Define files, records and fields. 
• Define key fields. 
• Describe the different data types. 

Figure 13.1 
A mailing list database 
stored on index cards. A database is a collection of related information. 

You have probably been exposed to a database of 
one kind or another at some time, perhaps one like 
the simple database pictured in Figure 13.1 , a mail­
ing list that is stored on index cards, or one more 
complex such as as the database in Figure 13.2 on 
the next page, a filing cabinet containing personnel 
information. In either case, the purpose of the data­
base is the same: to keep track of interrelated infor­
mation in an organized fashion. Databases are 
generally organized so that it is simple to find the 
information you need within the database quickly. 

James Frank 11 n I 'f043 State St. 
Los Angeles, CA 

I 00000 Joseph John 
2432 Palm Dr . 
Los Angeles, CA 

00000 Joan Herschel 
14 Date St . 
Los Angeles, CA 
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